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Hi Derivers,  

The Texas Instruments website has a free, collaborative forum where you can now share 
your favorite Derive activities and upload Derive worksheets and math files.  The online 
Activities Exchange allows educators to post an activity that has proven effective in class 
- or browse submissions from colleagues.   

For more information on the Activities Exchange, visit 
 

http://education.ti.com/exchange . 
 
From this page, you can browse by subject or TI product; search for specific activities; or 
submit a new activity.  When you click on the "Submit an activity" link you will be asked 
to log onto the TI web site.  (If you don't already have a User Name and Password, sim-
ply register to create one.)  Afterwards, you will be guided through a series of screens to 
input the activity information and upload activity file(s).  Please complete all the online 
template components (e.g., "before the activity, "during the activity", "other materials", 
"after the activity", etc.) as more information encourages activity usage. 
Below are links to example Derive activities:  
http://education.ti.com/educationportal/activityexchange/activity_detail.do?activityid=41
70&cid=us  

http://education.ti.com/educationportal/activityexchange/activity_detail.do?activityid=41
72&cid=us  

Regards,  

Theresa Shelby 
Texas Instruments  

I am very grateful for permission to present one sample lesson in this DNL as a mouthwatering (page 
33), Josef 
 

CAME 2005 Symposium: Second Announcement 
Shaping Research and Development of  

Computer Algebra in Mathematics Education 
 

To be held in October 19-20, 2005 in Roanoke, Virginia USA 
in conjunction with PME-NA-27, October 20-23, 2005  

http://www.pmena.org/2005/ 
Themes of the Symposium 
1. CAS, instrumentation and the anthropological approach 
Presenter: John Monaghan, University of Leeds, UK  
2. The impact of CAS on our understanding of mathematics education  
Presenter: Werner Peschek, University of Klagenfurt, Austria 
3. Teacher learning while teaching with CAS 
Presenter: Baerbel Barzel, Universität Duisburg-Essen, Germany 

Each of the three themes will be addressed in plenary lectures and in topic groups, where the issues 
will be worked on in more detail, based on the experiences of the participants. The topic groups will 
aim at producing a synthesis of the discussions in the plenary and topic group sessions. In the discus-
sion groups there will be, apart from time set aside to discuss issues arising from the plenary ad-
dresses, opportunity for further short presentations.  
The plenary papers will appear on CAME's Website before the Symposium: 
http://www.lonklab.ac.uk/came/ 
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Dear DUG members, 

When I started collecting stuff for DNL#58 I 
intended to end up with about 40-44 pages. As you 
can see it became more than 50 pages. There is one 
contribution from Rüdeger Baumann not only an-
swering an until now unanswered challenge but 
also offering a fine introduction in treating strings 
and in programming with them. Speaking about 
programming Titbits 30 must be mentioned. Johann 
Wiesenbauer recommends his Titbits because of 
containing some examples of very efficient pro-
gramming. In my opinion Titbits 30 dealing with 
elliptic curves are one of his very best in his long 
series of Titbits published in the Newsletters so far, 
many thanks Johann, outdoing yourself once more.  

I am very grateful for permission to reprint 
Carl Leinbach´s paper on GPS which can be found 
among the many activities which can be 
downloaded from the TI-website (Information 
page). Carl´s contribution is a mouthwatering ex-
ample standing for many other papers. There is 
only little experience needed to transfer the activi-
ties from PC to handheld and vice versa. 

Please notice the many announcements of use-
ful websites and conferences presented in this 
DNL. 

Last weekend I was in the happy position to 
attend USACAS 3 in Atlanta. There is a wonderful 
group of enthusiastic US-teachers led by JIm 
Schultz, Natalie Jakucyn and Bob Mc Collum who 
want to propagate the use of CAS in US curricu-
lum.  

Natalie Jakucyn made it possible to organize a 
CAS-strand at the 2006 NCTM Regional Confer-
ence in Chicago. Please support this great idea by 
submitting a CAS-related paper (deadline 11 July 
2005, see last page!!). 

Thanks also to Ernest Carpenter from South 
Africa – he urged to publish the Coons article – for 
his mails and the provided websites on “NURB-
surfaces”.  

I wish you a wonderful summer and am looking 
forward to providing DNL#59 and the revised 
DNL#7 in fall. 
Best regards to you and your families 

 
 

 
Some Australian websites: (University of Melbourne) 
extranet.edfac.unimelb.edu.au/DSME/CAS-CAT/ 
 
extranet.edfac.unimelb.edu.au/DSME/RITEMATHS/ 
 
edfac.unimelb.edu.au/DSME/ 
 
www.vcaa.vic.edu.au/vce/studies/mathematics/caspilolt/casindex.html 
 
2003 PME Proceedings online:    online.terc.edu/ 

Canadian website:    www.edu.gov.on.ca 

Individuals on Ontario schools who could provide additional information: 
Thomas_Steinke@occdsb.on.ca    and  fred.ferneyhough@peelsb.com. 
 
A Derive dedicated website in Belgium:  http://cage.ugent.be/~svw/DfW/ 

 
Download all DNL-DERIVE- and TI-files from 
 

http://www.austromath.at/dug/ 

http://www.bk-teachware.com/main.asp?session=375059 
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The DERIVE-NEWSLETTER is the Bulle-
tin of the DERIVE & CAS-TI User Group. 
It is published at least four times a year 
with a contents of 44 pages minimum. The 
goals of the DNL are to enable the ex-
change of experiences made with DERIVE 
and the TI-89/92/Titanium/Voyage 200 as 
well as to create a group to discuss the 
possibilities of new methodical and didac-
tical manners in teaching mathematics. 
 
As many of the DERIVE Users are also 
using the CAS-TIs the DNL tries to com-
bine the applications of these modern tech-
nologies. 
 

Editor: Mag. Josef Böhm 
A-3042 Würmla 
D´Lust 1 
Austria 
Phone/FAX: 43-(0)2275/8207 
e-mail:  nojo.boehm@pgv.at 

Contributions: 
Please send all contributions to the Editor. 
Non-English speakers are encouraged to 
write their contributions in English to rein-
force the international touch of the DNL. It 
must be said, though, that non-English 
articles will be warmly welcomed nonethe-
less. Your contributions will be edited but 
not assessed. By submitting articles the 
author gives his consent for reprinting it in 
the DNL. The more contributions you will 
send, the more lively and richer in contents 
the DERIVE & CAS-TI Newsletter will be. 
 
 
 
 
 
 
Next issue:  September 2005 
Deadline  15 August 2005 

 
Preview:  Contributions waiting to be published (selection) 
 
 Pringles, B. Grabinger, GER 
 Two Stage Least Squares, M. R. Phillips, USA 
 Some simulations of Random Experiments, J. Böhm, AUT & L. Kopp, GER 
 Wonderful World of Pedal Curves, J. Böhm 
 Another Task for End Examination, J. Lechner, AUT 
 Tools for 3D-Problems, P. Lüke-Rosendahl, GER 
 ANOVA with DERIVE & TI, M. R. Phillips, USA 
 Hill-Encription, J. Böhm 
 Farey Sequences on the TI, M. Lesmes-Acosta, COL 
 Simulating a Graphing Calculator in DERIVE, J. Böhm, AUT 
 Henon & Co, J. Böhm 
 Challenges from Fermat, Bj. Felsager, DEN 
 Are all Bodies falling equally fast, J. Lechner, AUT 
 Modelling Traffic Density, Th. Himmelbauer, AUT 
 Do you know this? Cabri & CAS on PC and Handheld, W. Wegscheider, AUT 
 An Interesting Problem with a Triangle, P. Lüke-Rosendahl, GER 
 Diophantine Polynomials, Duncan McDougall, CAN 
 Rosettes, J. Lechner, AUT 
 Jacobi-Iteration, Heinz Rainer Geyer, GER 
  

 and Setif, FRA; Vermeylen, BEL; Leinbach, USA; Koller, AUT; Baumann, GER; 
 Keunecke, GER, .........and others 

 

Impressum:  
Medieninhaber: DERIVE User Group, A-3042 Würmla, D´Lust 1, AUSTRIA 
Richtung: Fachzeitschrift 
Herausgeber: Mag.Josef Böhm 
Herstellung: Selbstverlag 
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Steve Schonefeld                                                                                    sschonefeld@mchsi.com 
 
Hi Joseph & Noor. 

Every time I look at my poster from the Montreal DERIVE/TI conference, I remember the folks in 
charge of that conference confiding that the graphics for that poster were not created using DERIVE.  
They were created using MAPLE.  I hope we can remedy that for the next conference.  DERIVE can 
create many beautiful and interesting graphics.  Perhaps members of DUG can contribute graphics for 
the next poster.  Let me start the ball rolling with the attached contribution.  It is a torus wrapped in a 
torus knot. 
Wishing you and yours a happy Easter. 
Steve Schonefeld 
 

 
 
 
 
 
Great idea! 
  
So let´s open a contest for the DES-TIME 2006 
poster. 
 

 
 

DES-TIME 2006 in Dresden, Juli 20 – 23, 2006 
 

www.des-time-2006.de 
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Ignacio Larrosa Cañestro                                                                             ilarrosa@mundo-
r.com 
 
I define the function s(n) and then I simplify to obtain a list for s(n): 

  
But it's correct only until n = 101, s(101) = 383. Above n = 101, I get incomprensibly s(n) = n ... 
 
Note that s(n) must be strictally increasing, because DIVISOR_TAU(n) > 1 if n > 1. And 
DIVISOR_TAU(i) works well for any of that values. 
(DIVISOR_TAU(n) = number of divisors of n.) 
 
I try it with Derive 6.10 and Derive 5.06, getting exactly the same results. I don't understand any-
thing. 
 
Best regards, 
 
Ignacio Larrosa Cañestro 
A Coruña (España) 
 
 
Albert D. Rich 
 
Hello Ignacio, 
  
If the difference between the upper and lower limits of a definite sum is greater than 100, Derive at-
tempts to compute the sum by finding an anti-difference and substituting in the limits.  This is analo-
gous to using anti-derivatives to compute definite integrals.  See Derive's on-line help on summation 
for details. 
  
This is the reason for the change in behavior of s(n) for n>101.  Unfortunately, the anti-difference for 
DIVISOR_TAU(i) is not computed correctly because of calls on special functions like FACTORS. 
  
Until this problem is resolved in a future release of Derive, you can force Derive to directly compute 
definite sums using iteration instead of trying to find an anti-difference by specifying a step size of 1.  
Thus if s(n) is defined as 
  

s(n) := SUM(DIVISOR_TAU(i), i, 1, n, 1) - n 

instead of as 
s(n) := SUM(DIVISOR_TAU(i), i, 1, n) - n 

 
then s(102) simplifies to 390. 
  
Hope this helps. 
  
Aloha, 
Albert D. Rich 
Co-author of Derive 
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Tania Koller, St.Pölten, Austria                                                                                  

Some of Tania´s students had problems with annotating new plots in the 2D Plot Window. 
I came across this strange behaviour, too and I could not find the reason for its occurrence. 
  
I wanted to plot y = x, y = x^2/4+x/2-1 and f(x):=2 sin(3x) with annotating the graphs, but the variables 
didn´t appear as shown on the screen shot. 
  
Any idea what happened?? 
 

 
 
 
Theresa Shelby 
Thank you very much for the information and the file.  The mystery is solved! 
  
After the annotation is created, Derive substitutes the Horizontal Axis Title for every occurrence of x 
and the Vertical Axis Title for every occurrence of y in the annotation of a plotted expression.  Cur-
rently, if a title in the plot window's Options > Display > Axes is blank, then an empty string will be 
substituted into the annotation.  So, in this case, if both the horizontal and vertical axis titles are blank, 
"y=x" becomes "=" and  "y = x^2/4+x/2-1" becomes "=^2/4+/2-1". 
  
In order to keep the horizontal and vertical titles invisible, yet still preserving the annotations, I advise 
using the Options > Display > Axes tab to restore the default titles of "x" and "y" and choose a font 
color for the axes titles that's close enough to the background of the plot window (e.g., "white") so as 
not to be visible. 
  
For the next release of Derive, I will modify the code so that it does no substitution of the Axes Titles in 
the annotation if the title is empty.   
  
Aloha, 
Theresa 
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Status Variables saved? 
A question from a colleague:  Why is it not possible in DERIVE 6 to save status variables like Notation 
Digits, Output Decimal, ... as it was in Derive 5. Is there any way to do this.  
My advice was to create an INI.MTH containing all requested settings and then load this INI.MTH as a utility 
file. Is there a better way to modify the INI-file?? 

Second question: Preparing a presentation I came across that DERIVE 6 behaves strange in perform-
ing simplifications. I attach parab.dfw. ut(p1,p2) is the DERIVE 5 version giving the correct result in 
DERIVE 5, but giving a wrong simplification in DERIVE 6. It needs to rewrite the function as a pro-
gram, then it works properly in all cases. (ut_v6(p1,p2,u). 

   
Best regards 
Josef 

  
Albert Rich 
Your first question is answered in the Derive 6.10 on-line under the User Interface Questions of the 
Frequently Asked Questions and Answers section.  They are copied here: 
 
In order to restore the environment in effect at the time worksheets are saved, the expressions in the 
algebra window, as well as all the user-defined functions and variable assignments, are saved in dfw 
files.  In earlier versions of Derive, the values of state variables (for example, the precision; notation; 
radix base; and the exponential, log, and trig simplification settings) were not saved in dfw files.  This 
made it impossible to fully restore the worksheet’s environment when it was opened.  Therefore, De-
rive 6 saves the state variable values in dfw files (for details, see Using and Saving State Variables).  
So now if while working at 20 digits of precision you save a worksheet, that same precision is restored 
when the worksheet is re-opened.  
 
When earlier versions of Derive started and a new blank worksheet created, the state variable values 
were set to those in effect the last time Derive was shutdown.  These settings may have long since 
been forgotten by the user and/or not appropriate for the task at hand.  Therefore, to avoid confusion, 
when Derive 6 starts the state variable values are set to their factory defaults.  So there is no need to 
save state variable values in the initialization file.  However, Derive 6 continues to save the Windows 
state information (for example, window sizes and colors, printing options, etc.) in the file (for details, 
see the Derive Initialization File). 
 
Your second question:  This unfortunate bug occurs only in version 6.10 of Derive 6.  It has recently 
been found and corrected for the next release of Derive.  I apologize for the inconvenience. 
 
Aloha, 
Albert
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Ernest Carpenter (South Africa) 
Hi Josef, 
  
Thanks for the files relating to the Coons-Surfaces. I enjoyed it tremendously (especially after it was 
translated☺) for mainly the following reasons: 
  
¾ Firstly it was clear and nicely presented and made a topic, that usually make me feel more 

math-illiterate than I’m currently is due to the sometimes complex representation in literature, 
a little bit more understanding! 

¾ Working with CAD (Microstation, AutoCAD, etc.) and modeling systems (Amapi, Maya, 3D 
Max 5, Cinema 4D, etc.), I constantly use these NURB related surfaces without always fully 
understanding the main principles behind the construction – now it makes more sense! 

¾ It prompted me to ‘research’ the tools I use and get a better understanding of how big and 
complex curve and surface modeling are! (Interesting history - 
http://rt001kxn.eresmas.net/principal/history_CAGD.pdf) 

  
(one of the packages I also use is Eovia’s Amapi and a nice tutorial showing how some of these sur-
faces are used in modeling is: http://server2.eovia.com/tutorials/amapi6/shoe/) 
  
Right is a quick CAD representation of a NURB surface 
using a degenerated Coons-Gordon algorithm (Microsta-
tion) 
 
I also immensely enjoyed the new and revised DNL’s. 
 
As an exercise I ‘modeled’ the “Two Underground Tunnels” 
problem in CAD to see how the geometric results compare 
with the numerical results in DNL05. They are the same☺! 
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Rüdeger submitted this contribution some time ago, but this does not influence its inter-
esting nature. His article isiwritten in german and I will try to provide short English sum-
maries. In the original paper all functions, variables and programs have German names. 
To make it easier for our non-German speaking members I use English names. There 
are two DERIVE-files which can be downloaded: engel.dfw with the German names and 
engel_eng.dfw with the English names. Most of the problems and solutions are self ex-
planatory. I added the respective solutions for our many TI-CAS users. Josef 

 

Engelfolgen und Schieberegister 
Zum Umgang mit Zeichenketten und Zahlen 

Engel Sequences and Shift Registers 
How to treat Strings and Numbers 

Rüdeger Baumann, Celle 
 
Wie viele Anfragen und insbesondere auch die Leserzuschriften in DNL 49 zeigen, besteht nach wie 
vor Bedarf an elementaren Einführungsaufgaben und Übungen zum Programmieren in Derive. Zwar 
hat Josefs Buch hier Abhilfe geschaffen – aber andererseits sind natürlich noch Fragen offen geblie-
ben. Im folgenden sollen einige elementare Überlegungen zur Behandlung von Zeichenketten und 
Zahlen angestellt werden, die erfahrungsgemäß dem Anfänger Schwierigkeiten bereitet. Als Anwen-
dung werden zwei interessante Aufgaben gelöst. 

There are many requests on introductory examples and exercises in programming in Derive. In this 
contribution some elementary considerations on the treatise of strings and numbers are presented. 
Then using the acquired knowledge two interesting problems will be solved. 
 

Elementare Operationen 
Zeichenketten (engl.: strings), also (aus Buchstaben, Satzzeichen, Ziffern usw. gebildete) Wörter und 
Sätze werden zwischen obenstehende „Gänsefüßchen“ (engl.: double quotes) eingeschlossen. Die 
Operationen für Zeichenketten und Listen (in Derive: Vektoren) sind eng miteinander verwandt: man 
kann die Listenoperationen auch auf Wörter, Zahlen und Texte anwenden. Die drei Beispiele behan-
deln die wechselseitige Umwandlung zwischen Zahlen, Zeichenketten und Listen. 
 
Beispiel 1: Eine gegebene Zahl soll in eine Zeichenkette verwandelt werden – und umgekehrt. 
Example 1: A given number shall be transformed into a string – and vice versa. 

Die Aufgabe Zahl in Wort (NumberToWord) lässt sich sehr einfach mit Hilfe der Funktion STRING 
lösen: 
 

 

["-", 314159/100000] 

 
This is the way, the result 
appears in Exact Simplification. 
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Die Umkehrung Wort in Zahl ist nicht ganz so einfach, denn ein Wort kann Zeichen enthalten derart, 
dass es sich nicht als Zahl interpretieren lässt. Wir wandeln das Zahlwort zunächst – mit Hilfe der 
Funktion NAME_TO_CODES – in eine Liste von ASCII-Nummern um: 
The reverse operation WordToNumber is not so easy, because there might be characters which can-
not be interpreted as a number. At first we transform the number-word into a list of ASCII-Codes. 
 

  
Auf diese Liste wenden wir die Funktion CODES_TO_NAME an, die aus einer Liste von ASCII-
Nummern eine Zahl macht. Sie weist allerdings Besonderheiten bezüglich der Null auf: 
 
CODES_TO_NAME([48]) = 0 

CODES_TO_NAME([48, 51]) = 3  
Das heißt, die vordere Null wurde weggelassen. Aus diesem Verhalten entstehen zuweilen Komplika-
tionen. Insgesamt erhalten wir 
 

  
Das Argument ist ein String, daher unter " zu schreiben. 
 
As you can see the leading zero is omitted. This might cause sometimes problems. The argument is a 
string and must be written under ". It works with negative integers, but not with negative decimal num-
bers.   

 
The CAS-TIs provide two functions string(number) and expr(string) for these purposes: 
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Beispiel 2: Einer natürlichen Zahl soll die Liste ihrer Ziffern zugeordnet werden – und umgekehrt. 
Example 2: A natural number shall be assigned to the list of its digits – and vice versa. 

Bei einer Zahl n kann man die i-te Ziffer (von links) durch n SUB i (bzw. n↓i) herausgreifen: 
 

  
Even entering NumberToList(03141590) the leading zero does not appear in the Algebra Window. 
 
Die Umkehrung Liste in Zahl geht wie folgt: Wir definieren eine Funktion asc durch 
 

  
Die Funktion NAME_TO_CODES liefert eine Liste; ihr entnehmen wir mittels FIRST das erste (und einzi-
ge) Element. 
 

  
Es gibt auch eine rein arithmetische Lösung: 
 

  
Die Ziffern werden in umgekehrter Reihenfolge aufgelistet! Dies kann manchmal nützlich sein. Wün-
schen wir uns die Ziffern in normaler Reihenfolge, hängen wir sie mittels APPEND hinten an. Da diese 
Funktion Listen verkettet, machen wir aus der Ziffer MOD(n,10) durch Einschließen in eckige Klam-
mern eine (einelementige) Liste. Die Funktion lautet: 
 

 
NumberToList1 returns the digits in reverse order which can be useful sometimes. To obtain the regu-
lar order we use APPEND instead of ADJOIN. Take care for the brackets enclosing the digit MOD(n,10) in 
NumberToList2 making this digit to a list containing only one element. This is necessary, because 
APPEND works with lists only. 
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Beispiel 3: Einer gegebenen Zeichenkette soll die Liste ihrer Zeichen zugeordnet werden – und umge-
kehrt. 
Example 3: A given string shall be assigned to the list of its charcters – and vice versa. 

Die Aufgabe Wort in Liste löst sich analog zu Beispiel 2: 

 
Für die Umkehrung Liste in Wort orientieren wir uns ebenfalls an Beispiel 2: 
ListToWord0(v) will resolve the problem with the omitted leading zero(s). 

 

  
 

Die Engelfolge / The Engel Sequence 
 
In der Zeitschrift Praxis der Mathematik stellte Arthur Engel im Jahr 1967 folgende Aufgabe:  
1967 Arthur Engel posed a problem in Praxis der Mathematik: 

„Es werden die zehn Ziffern z1, z2, ..., z10 beliebig angenommen. Diese Ziffernfolge wird nach 
dem Gesetz zn = zn–10 + zn–9 (mod 10) mit n = 11, 12, 13, ... fortgesetzt. Man zeige, dass die Folge 
periodisch wird, ja sogar sofortperiodisch. Was kann man über die Periodenlänge aussagen?“ 

Let z1, z2, ..., z10 ten arbitrary digits. This sequence is continued according to the following rule:  
zn = zn–10 + zn–9 (mod 10) with n = 11, 12, 13. Show that this sequence is periodical and that there 
is no preperiod appearing. 

Beispiel/Example: 1234567890  3579135793826048... 

Wir wollen hier – als Anwendung der Überlegungen zu Zeichenketten und Zahlen – die Erzeugung 
der Folge programmieren. Zunächst hat man sich zu entscheiden, ob die Folge als Liste, Zahl oder 
Zeichenkette geschrieben werden soll. Es handelt sich um Ziffern, die modulo 10 addiert werden: dies 
spricht für die Verwendung von Zahlen. Andererseits müssten wir dann auf weit zurückliegende Zif-
fern einer (großen) Zahl zugreifen, die Zahl um eine Stelle verlängern und die neue Ziffern als Einer-
ziffer anfügen: dies scheinen schwierige arithmetische Operationen zu sein. Somit empfiehlt sich die 
Verwendung von Zeichenketten. 

Instead of working with numbers we recommend the use of strings because we have to refer to num-
bers lying far back and form new numbers. This seems to cause difficult arithmetic operations. 
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Wir stellen zunächst die Länge k des gegebenen Worts (Ziffernfolge) fest und bauen dann eine Schlei-
fe (LOOP) auf, die zur Bestimmung der i-ten Ziffer (i > k) um k bzw. um k – 1 Schritte zurückgreift: 
Folge SUB (i – k) bzw. Folge SUB (i – k + 1). Da es sich um Zeichen handelt, müssen sie in 
Zahlen umgewandelt werden (siehe oben), die sich dann modulo 10 addieren lassen und rechts ange-
hängt werden. Hier wirkt die Funktion APPEND auf Zeichenketten (von Derive als Listen aufgefasst). 

Um die aus der Folge herausgegriffenen Ziffern als Zahlen behandeln zu können, müssen wir die Auf-
gabe Ziffer in Zahl lösen: 

As we have to treat the digits as numbers we have to solve the problem DigitToNumber. 

 

Zuerst wird der Ziffer (hier: 3) ihre ASCII-Nummer (51) zugeordnet und sodann die der Null (48) 
abgezogen: 51 – 48 = 3. 
 
The program arthur(start, length) with first results: 
 

 

 
Can you find the periods? 

Arthur(862, 20) = 86248624862486248624 
Arthur(555, 20) = 55500505550050555005 
Arthur(268, 50) = 26884620828008088866420626884620828008088866420626 
Arthur(220, 50) = 22042466026288068644084822042466026288068644084822 
Arthur(5000, 50) = 50005005505055550005005505055550005005505055550005 
 

Wir finden bei dreistelligen Anfangswörtern die Periodenlängen 4 (1), 7 (1), 24 (5), 28 (1), 168 (5); in 
Klammern steht jeweils die Anzahl der Zyklen. Probe: 1 · 4 + 1 · 7 + 5 · 24 + 1 · 28 + 5 · 168 = 999. 
Die Periodizität mittels Programm zu erkennen, scheint schwierig. Leider ist das in DNL#47, S. 38 
gestellte Problem der Erkennung von Perioden noch nicht gelöst. 
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Rüdeger notes that the problem to detect periods has not been solved until now (posed in DNL#47). 
This was reason enough for me to make a try: 

 
This program works, but to keep it more general it would be fine to also find out if there is a preperio-
dical part existing. So look at the following: 

 

Some other examples to illustrate period?(string): 
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We can finally count all appearing periodics. #119 - #123 shows the end of this procedure. Rüdeger 
started with "001" giving 999 three digit starting numbers. I start with "000" resulting in 1000 Engel-
Sequences with a three digit initialisation number. 
 

 
 

  
 
I´ll leave the program for period detecting with the TI as a challenge for the reader. 
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Die Erzeugung der Folge können wir uns mittels eines sogenannten Schieberegisters vorstellen (siehe 
Engel 1991, S. 105 ff). Ein Schieberegister (engl.: shift register) besteht aus einer Aneinanderreihung 
von Speicherzellen, die so geschaltet sind, dass – auf einen Taktimpuls hin – der Inhalt jeder Zelle an 
die linke Nachbarzelle weitergereicht wird. Dazu gehört eine Rückkopplungsschaltung, deren Eingän-
ge mit bestimmten Zellen verbunden sind, und deren Ausgang in den Eingang des Schieberegisters 
mündet. Die zugehörige (Pseudo-) Zufallsfolge wird von den Zahlen gebildet, die aus der Zelle am 
linken Rand heraustreten. 

 
Bild1/Figure 1 
Shift Register 

We can imagine creating the sequence using a so called 
shift register (Engel, 1991). This consists of a sequence of 
cells, which are connected in such a way that at each clock 
pulse the content of each cell is transmitted to its left neigh-
bour. A reaction coupling is connected with certain cells as 
input and gives an output which feeds the sequence from 
the right side. The respective sequence of (pseudo) random 
numbers is formed by the numbers which leave the register 
at its left end. 

 
Die einfachste Version ist ein linear rückgekoppeltes Schieberegister (engl.: linear feedback shift regi-
ster): hier besteht die Rückkopplungsschaltung aus einer XOR-Verknüpfung (Exklusiv-Oder) der an-
gezapften Zellen, was mathematisch der Addition modulo 2 entspricht. 

Die Folge der angezapften Zellen, das Anzapfmuster (engl.: tap sequence), stellen wir durch einen 
Null-Eins-Vektor dar (in Bild 1 wäre dies [1, 1, 0, 0, 0, 0]). Dann kann das neue Bit mittels skalarer 
Multiplikation (in Bild 1: MOD([1, 0, 1, 1, 1, 0] · [1, 1, 0, 0, 0, 0], 2) = 1) bestimmt werden. 

The simplest version is a linear feedback shift register (LFSR) whose input is the XOR-operation (ex-
clusive or) of some of its outputs. These output cells are called taps. The tap sequence is represented 
by a binary vector. Here it is [1,1,0,0,0,0] because the first two cells are connected by XOR giving the 
next cell which is here 1 XOR 0 = 1. This new bit can be calculated by a dotproduct modulo 2 of the 
register content vector and the tap sequence vector MOD([1, 0, 1, 1, 1, 0] · [1, 1, 0, 0, 0, 0], 2) = 1. 

The following program for producing a (pseudo) random binary sequence uses working with strings. 
Let´s assume that we have already produced the sequence 10111011001 and we want to generate  
bit #12 (i = 12). We need a "window" [6, 7, 8, 9, 10, 11] which selects the last k = 6 bits. 

Das folgende Programm macht von einer wichtigen Möglichkeit der Bearbeitung von Zeichenketten 
Gebrauch: man kann aus einer Zeichenkette durch Vorgabe einer Liste mittels der Operation SUB ge-
zielt Elemente herausgreifen. Es sei beispielsweise die Folge 10111011001 bereits gewonnen, und nun 
soll das zwölfte Bit erzeugt werden (i = 12). Dazu bilden wir das „Fenster“ [6, 7, 8, 9, 10, 11], mit 
dessen Hilfe die k = 6 letzten Bits herausgegriffen werden: 

 
Werden sie mit dem Anzapfmuster skalar multipliziert, ergibt sich das neue, in den Eingang zurückge-
führte Bit: 
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Damit bekommen wir das folgende Programm: 

 
We investigate the periodic behaviour: 

 
 
Das Schieberegister liefert die maximale Periodenlänge 26 – 1 = 63. Die Erzeugung von Zufallszahlen 
mittels Schieberegister spielt in der Kryptologie eine wichtige Rolle (siehe Schneier 1991, S. 373 ff). 
 
Another LFSR with period length 127: 
 

 
 
Note: 
It might make sense to let students produce a number of elements of a LFSR-generated sequence by 
hands first to understand the process – and then check it using the program, Josef 
 
For example: start with 1,0,1,0,1,1 and use the tap sequence 1,1,0,0,1,1 



1 0 1 0 1 1

1 0 

1 

1 0 1 0 1 1 1

1 0 

1 

1 0 1 0 1 1 1 1

1 0 

1 10 0 1 1 1 11 1

1 

1 

1 

0 

1 10 0 1 1 1 1 1 1

0 1 

0 

1 0 1 0 1 1 1 1 1 1 0

0 1 

1 
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Compare with the Derive output (you don´t see the quotes in the Algebra Window!): 

sr("101011", "110011", 12) = "101011111101" 

Let's first investigate its periodic behaviour and then perform the calculation on the CAS-TI: 
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Die Schornfolge / The Schorn Sequence 
 
In DN# 49 (S. 39) wurde Engels Aufgabe von Richard Schorn wie folgt abgeändert:  
In DNL#49 (p 39) Richard Schorn varied Engel´s problem as follows: 

Eine Folge von Zahlen soll dadurch erzeugt werden, dass Einer- und Zehnerziffer (modulo 10) 
addiert und vorne angehängt werden, die Einerziffer aber entfällt. 
Generate a sequence of numbers by adding the last two digits of an integer (modulo 10) and put-
ting the result at the beginning of the number, omit the last digit. 

Beispiel / Example: 3718, 9371, 8937, 0893, 2089, ... 

Bei Engel geht es somit um eine Folge von Ziffern, bei Schorn um eine Folge von Zahlen – ein be-
trächtlicher Unterschied. Dennoch hängen beide Folgen eng miteinander zusammen. 
Engel Sequence is a sequence of digits, Schorn sequence is a sequence of numbers – quite a diffe-
rence, but both kinds of sequences show a tight connection. 
fillZeros(word) is an auxiliary function to show the leading zeros (as in 0893). 

 
Another example: Instead of taking the last two digits we take the first two ones. Derive recognizes 
6798174312 as starting number of a repeating cycle. 

 

 
Richard bestätigt also die oben festgestellte Periodizität der Folge mit 5000 als erstem Element. Die 
Gleichung 1 · 15 + 2 · 312 + 6 · 1560 = 9999 festigt die Vermutung, dass es einen Zyklus mit 15, zwei 
Zyklen mit 312 und sechs Zyklen mit 1560 Elementen gibt. Was sagt Arthur dazu? 

Richard confirms periodicity of the sequence initialized by 5000. Equation 1¥15+2¥312+6¥1560=9999 
consolidates the conjecture that there is one cycle with 15, two cycles with 312 and six cycles with 
1560 elements. What is Arthur´s opinion? 
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Arthur("2000", 322) = 
"20002002202422664820202222444688046840424466802482620882860046040644608068864640004004
404844228640404444888266082680848822604864240664620082080288206026628280008008808688446
280808888666422064260686644208628480228240064060466402042246460006006606266882460606666
22284402842026228840624686044648002802082280408448282000200220"  
 
DIM(periode?(Arthur("2000", 322))) = 312 
 

Aufgaben / Tasks 
 
1. Welcher Zusammenhang besteht zwischen den Engel- und den Schornfolgen? Kann man insbeson-

dere aus der Periodizität der Schornfolgen auf die der Engelfolgen schließen? 
Which connection is between Engel sequences and Schorn sequences? Is it possible to deduce 
periodicity of Engel sequences from periodicity of Schorn sequences? 

 
2. Untersuchen Sie die vom Schieberegister mit der Anfangsbelegung 10101110011 und dem An-

zapfmuster 10100000000 erzeugte Folge. Hat sie maximale Periodenlänge? 
Investigate the sequence generated by a shift register with initial sequence 10101110011 and tap 
sequence 10100000000. Is this sequence of maximum period length? 

 
3. In der Folge 1983113835952... ist jede Ziffer ab der fünften die mod-10-Summe der vier vorange-

henden Ziffern. Enthält die Folge das Wort (a) 1234, (b) 3269, (c) 5198, (d) nochmals 1983? Expe-
rimentieren Sie mit verschiedenen Anfangswerten.  Wie hängt die Periodenlänge vom Anfangswert 
ab? 
In the sequence 1983113835952... each digit starting with the fifth is the mod 10 sum of its four 
predecessors. Das this sequence contain the words (a) 1234, (b) 3269, (c) 3269, (d) again 1983? 
Experiment with various initial values.  How does period legth depend on the intial value? 

 
4. Angenommen, ein Kryptanalytiker hat die Teilfolge 00100110 eines linearen Vier-Bit-Schiebe-

registers abgefangen und möchte den weiteren Verlauf der Folge voraussagen. Zu diesem Zweck 
sucht er das Anzapfmuster zu ermitteln. Helfen Sie ihm! 
Assumed a cryptoanalyst intercepted a partial sequence 00100110 of a linear four-bit-shift register 
and wants to predict the following elements. For this purpose he tries to detect the tap sequence. 
Can you help him? 
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Coons[1, 2]-Surfaces with DERIVE and CAS-TI 
Josef Böhm 

We start constructing a surface above the unit square in the first quadrant which is bounded by four 
connected straight lines. Two lines are lying in the xz-plane and yz-plane, the other two lines are lying 
in the parallel verical planes. 

We have four vertices: P00(0,0,-1), P10(1,0,5), P11(1,1,1) and P01(0,1,3). 
We designate the line in the xz-plane as gx0 (points on it have variable x-values and y = 0 = constant: 
gx0(P00,P10). Analoguous definitions for gx1(P01,P11), g0y(P00,P01) and g1y(P10,P11). 
 
DERIVE can help producing a sketch of the situation. 

                              
It is easy to produce the four lines in parameter form. The parameters are running from 0 to 1. We 
have to take care that opposite lines show the same orientation. It is no problem to name the parame-
ters as x and y! 

 

Via [gx0(-1,3,5,1),gx1(-1,3,5,1),g0y(-1,3,5,1),g1y(-1,3,5,1)] and Insert > Plot 
in the 3D-Plot Window we obtain the representations of the segments with boundaries 0 and 1 for the 
parameter. Don´t forget to activate the box  Apply parameters to rest of plot list. 

We can imagine two points X0 and X1 on two opposite lines 
gx0 and gx1 which are generated by the same parameter 
value x. We transfer these two points and the connecting 
segment to the graph. This segment lies parallel to the  
yz-plane and needs parameter y for any constant x. 

Running x and y between 0 and 1 we receive a set of points, 
which form a surface in 3D-space. We found its parameter 
representation – with parameters x and y (which are s and t 
for DERIVE.)  

(Left matrix produces the vertex points and the right 
one connects these points to a closed polygon in 3D 
space.) 
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Inspecting the parameter form of the surface we find that the third component is nothing else than 
explicit representation of the z-values ot the surface: 

( , ) 8 6 4 1 mit 0 , 1z x y xy x y x y= − + + − ≤ ≤  

In DERIVE notation this reads as 

IF(0 ≤ x ≤ 1 ∧ 0 ≤ y ≤1, 2x(3 - 4y) + 4y - 1, ?) 

So let´s wrap this into one function depending on the z-values of the four corner points: 

 

   
 
Rewriting the third component – z(x,y) – shows that it might be interpreted as a product of vectors and 
a matrix in two ways: 
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This leads to another – and more compact - definition of the surface: 

 

First generalization 

The base figure shall no longer be only a square but a rectangle with x0 ≤ x ≤ x1 and y0 ≤ y ≤ y1. We 
change the vertices to 

P00(0,0,1), P50(5,0,6), P53(5,3,-1) and P03(0,3,2). 

Parameter representation of the segments must be 
changed for accepting the default parameter boundaries 
0 and 1 to run from x0 to x1 and from y0 to y1. 

The sketch shows a top view for (x0,y0) = (2,1) and 
(x1,y1) = (5,6). Default values for function  
bilin_rect() are (0,0) and (1,1). 

 
bilin_rect(z00, za0, zab, z0b, x0:=0, y0:=0, x1:=1, y1:=1, zxy):=  
         prog( 

              zxy:=([1 - (x - x0)/(x1 - x0), (x - x0)/(x1 - x0)]· 
                    [z00, z0b; za0, zab]· 
                    [1 - (y - y0)/(y1 - y0); (y - y0)/(y1 - y0)])™1, 
              IF(x0 “ x “ x1  y0 “ y “ y1, zxy, ?) 
             ) 
 

 

This function seems to work properly and we try to produce two parallel surfaces. 
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Additional exercise: 
Find the boundary lines and scale in such a way that the range for the parameter is from 0 to 1 for all 
segments. (see DERIVE file). 
[zrx0(1, 2, 6, -1, 0, 0, 5, 3), zrxb(1, 2, 6, -1, 0, 0, 5, 3), 
 zry0(1, 2, 6, -1, 0, 0, 5, 3), zrya(1, 2, 6, -1, 0, 0, 5, 3)] 
 

   

It might be useful for students to repeat the relationship between the parameter form and explicit form 
of the surface: 

 

It is not really difficult to transfer this to the TI-89/TI-92/Voyage 200: 
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Second generalization 

The second generalization is much more challenging: two curves lying in opposite parallel vertical 
planes form the boundary of the surface. We denote the pair of curves either as (zx0(x), zxb(x)) – lying 
in planes perpendicular to the y-axis or as  (z0y(y),zay(y)) if lying in two planes perpendicular to the x-
axis. 
Let´s choose the following base rectangle [(1,2), (5,2,), (5,10), (1,10)]. 
 
As first example I´ll take two parabolas, which should form a surface for 1 ≤ x ≤ 5 and 2 ≤ y ≤ 10.  

 

For representing the two boundary curves in R3 we have to create space curves. This shall be auto-
mated: DERIVE shall learn from the appearing variables – x or y – which type is needed. 

 

  

Remaining work is not difficult. Pairs of points of the two "profile curves" c0 and c1, which are gener-
ated by the same parameter value must be connected. 

(1 0 1y yc c
b b

 − ⋅ + ⋅ 
 

 oder 1 0 1x xc c
a a

 − ⋅ + ⋅ 
 

 is the "raw form", assuming one cornerpoint of the base 

rectangle being the origin with legths a and b of the rectangle sides. Let´s define a general function 
and we don´t have to take care for scaling in the future: 
bi_curves(k0,k1,x0:=0,y0:=0,x1:=1,y1:=1,zxy):=prog( 
              zxy:=IF((VARIABLES(k0))™1=x, 
                         (1-(y-y0)/(y1-y0))·k0+(y-y0)/(y1-y0)·k1, 
                         (1-(x-x0)/(x1-x0))·k0+(x-x0)/(x1-x0)·k1, 
                         (1-(x-x0)/(x1-x0))·k0+(x-x0)/(x1-x0)·k1), 
                   IF(x0 “ x “ x1  y0 “ y “ y1, zxy, ?) 
                                                  ) 

 
 
 
bi_curves(zx0,zxb,1,2,5,10) 
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Next example shows boundary curves lying in planes parallel to yz-plane. The surface is defined over 
the region described by 0 ≤ x ≤ 6 and 0 ≤ y ≤ 8. 

 

 

 
In DERIVE 6 we can suppress plotting the grid lines 
which leads to a kind of photo realistic pictures.  

 

 

And how does the TI-calculator perform? 

     

     



P06(0,6,6) 

P46(4,6,0) 

P00(0,0,3) 

P40(4,0,1) 
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The last generalization is the most difficult one and it finally leads to the Coons-Surfaces. All bound-
ary lines are - nonlinear – curves. Base figure is again a rectangle and the boundary curves are con-
nected above the vertices of the base rectangle.  
 
 
 
 
 
 
 
 
 
 
 
 
We produce four parabolas using quadratic regression.  

 

Ans we plot these four curves: 

zx0 zxb 

zay 

z0y 
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In our first approach we will assume that one vertex of the base rectangle is the origin. Legths of the 
sides of the rectangle are a (in x-direction) and b (in y-direction). This makes presentation clearer. In 
the original papers only the unitsquare (a = 1, b = 1) is used. 

 
The third expression contains the z-values of the "corner points", where the boundary curves connect. 
Later we will automate this, too. 
 
What follows now is the important and surprising point – for students and for teachers as well. 

The following matrix product delivers the explicit form of the surface: 

 

So we can proceed plotting the surface: 
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Before defining a working function we will try to derive the "Coons-formula". For this purpose we 
need an auxiliary function u(x,y) which decribes the boundary curves. (This part follows the 
references, but we will use DERIVE for the calculations.) 
 
First of all we add the two different forms of respresentation from bicurves(). 

( , ) 1 0 1 0y y x xz x y ux uxb u y uay
b b a a

   = − ⋅ + ⋅ + − ⋅ + ⋅   
   

. 

It is for sure that this surface does not contain the boundary curves! 
 
DERIVE enters the stage. 
 
We take care that ux0 and uxb are lying on the surface. 
 

 
 
Let´s have a check: 
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and what is much more surprising: 

 

I rewrite right side of the surface definition using z00, zxb, zay, zab etc. 

 

and have the question if this expression is identical with the matrix product from above? 

 
 
So we can finish, defining an appropriate function for the general case: 
 
coons(zx0,zay,zxb,z0y,x0:=0,y0:=0,x1:=1,y1:=1,z00,z0b,za0,zab,zxy):= 
           PROG( 
                "@ die z-values in the corner points", 
                z00 := LIM(zx0, x, x0), 
                z0b := LIM(z0y, y, y1), 
                za0 := LIM(zx0, x, x1), 
                zab := LIM(zay, y, y1), 
                zxy := ([1 - (x - x0)/(x1 - x0), (x - x0)/(x1 - x0), 1]· 
                        [-z00, -z0b, z0y; -za0, -zab, zay; zx0, zxb, 0]· 
                        [1 - (y - y0)/(y1 - y0); (y - y0)/(y1 - y0); 1])™1, 
                IF(x0 “ x “ x1  y0 “ y “ y1, zxy, î) 
               ) 
 

I´ll show some examples to inspire your own experiments. 
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As you can see it works also on the TI-92 / Voyage 200 
 

  
 

  
 
A variation of the surface from above: 
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It is not difficult to transfer the surface formula to DPGraph: 
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The TI-presentation looks a bit poor after the great 
DERIVE and DPGraph plots, but I find it remark-
able what can be done with these small devices 
algebraically and graphically as well. 
 

 
 
Finally I´d like to check my function once more comparing the function values of the two surfaces 
fl1 and fl2. 

 
So we don´t have to rely only on the optical impression but have an additional numerical confirmation. 
 
Final comment 
 
In April I had the occasion to give a 
workshop on Coons-Surfaces. 
The colleagues – teachers from Tyrol 
– enjoyed experimenting and creating 
their own surfaces. So they designed 
their fancy cars, etc. 
 
My friend Heiner Juen composed two 
surfaces for "Josef´s Helmet". Many 
thanks Heiner. I´ll keep it in honour. 

 

 
 
References: 
 
I found the Coons-Surfaces in a Belgian Teachers´ Journal [2]. Jan Vermeylen helped providing part 1 [1] of 
this contribution which contains the basics. Many thanks for this together with best regards to Belgium. 
 
[1] H.van Looy, Coonsoppervlakken bij computer aided design, Wiskunde & Onderwijs, 1990 
 
[2] L. Van den Broeck, Motorkappen en Coonsoppervlakken, Wiskunde & Onderwijs, 1996 
 
This is a related website:: 
http://olli.informatik.uni-oldenburg.de/Grafiti3/grafiti/flow11/page3.html 
See also additional webpages provided by Ernest Carpenter (User Forum). 
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Introduction to Global Position System 

Two Dimensional Preliminaries 
Carl Leinbach, Bigglerville, USA, leinbach@gettysburg.edu 

NOTE:  While working with this lesson, we recommend that you open a 2D-Plot Window and 
then choose the option Window > Tile > Vertically.  Later in this lesson, you will be asked to 
modify the range of the window using the Plot Window options Set > Plot Range.  Using this 
screen format, you will be able to follow the lesson and view the corresponding graphics displays 
that you will generate. 

 
Acknowledgement: This activity was inspired by a talk given by Mr. Ralph Irons of Central Shenan-
doah Valley Regional Governor's School at the 2001 T3 International Conference in Colombus, OH.  
His presentation can be found in the Proceedings of that Confence call "2001 a Technological Odys-
sey."  The presentation given here is distinctly different from that of Mr. Irons, but his excitement and 
exposition were the inspiration.  
  
Background - Step 1: 
 
The classical definition of a circle is: the locus of all points equidistant from a fixed point.  The meas-
ure of the distance from the fixed point is called the radius of the circle and the fixed point itself is 
called the center of the circle.  In the cartesian coordinate system a point is designated by a pair of real 
numbers, say (c1, c2).  Thus, we need three parameters to completely describe a circle: c1, the x-
coordinate of the center; c2, the y-coordinate of the center; and r, the radius of the circle.  Analytically, 
this tells us that the definition of a circle is the set of all points, (x, y) that satisfy the following equa-
tion based on the distance formula:      
 
              2           2    2 
#1:   (x - c1)  + (y - c2)  = r  
 

Derive allows you to plot expressions such as #1 provided the values of the parameters are defined. 

For example, if you wished to see the graph of a circle with center at (-1, 2) and radius 3, you simply 
highlight expression #1,  click on the SUB toolbar button and type in the respective new values for c1, 
c2, and r variables (parameters).  Click on OK to replace the parameters with your values. Switch to 
the plot window and click on the plot toolbar button or click Insert > Plot.  If you receive a message 
that says "Unable to Plot Highlighted Expression", open a 2D-plot window and click on Window > 
Approximate Before Plotting and try again. 

The resulting plot is the set of points, (x, y), satisfying the new values substituted in expression #1. 

What if you know some points on a circle and want to find the equation of the circle?  This is the re-
verse of our previous example.  We need to find the values of the parameters c1, c2, and r.  Once 
again, expression #1 is our road to success.  The first question we need to address is, how many points 
uniquely determine a circle?  Since we have three parameters to determine, it is sensible to guess that 
three points should do the job.  Of course, the points can not be co-linear.  Let's give it a try.   
 
Suppose we wish to find a circle passing through the three points (1, 1), (-2, 0), and (-1. -1). 
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First we copy expression #1 into the Derive Command Entry Line by highlighting it and pressing the 
F3 key.  Substitute 1 for x and 1 for y.  Press the Enter key.  The expression will remain in the Com-
mand Entry Line.  Alter the expression to reflect entering -2 for x and 0 for y.  Press enter again.  Re-
peat the process for the point (-1, -1). 

This results in the following three equations.   

              2           2    2 
#2:   (1 - c1)  + (1 - c2)  = r  
 
               2           2    2 
#3:   (-2 - c1)  + (0 - c2)  = r  
 
               2            2    2 
#4:   (-1 - c1)  + (-1 - c2)  = r  
 

Derive has a very powerful solver for systems of polynomial equations. 

Press Solve > System.  An inquiry box will ask you how many equations you wish to solve.  Indicate 
3.  A display similar to the one shown below appears.  Since you have the equations as part of your 
Derive worksheet, you need only enter the numbers of the expressions that have the three equations as 
shown below.     Click on the blank space in the Solution Variables area and then click Solve. 

 
 
The following two expressions are displayed on your Derive worksheet.  Note that in expression #6 
there are two answers.  Why?  
 
                    2           2    2           2           2    2         
#5:   SOLVE((1 - c1)  + (1 - c2)  = r , (-2 - c1)  + (0 - c2)  = r , (-1 -  
 
           2            2    2               
        c1)  + (-1 - c2)  = r , [c1, c2, r]) 
 
              1          1         √10           1          1           √10  
#6:   c1 = -  ∧ c2 =  ∧ r = , c1 = -  ∧ c2 =  ∧ r = -  
              2          2          2            2          2            2   
 
At this point we enter the solution for c1, c2, and r into expression #1 and plot the circle. 
 
                               1 2        1 2    √10 2 
#7:                     x - -   + y -   =   
                               2          2       2    
Exercise 
     1.  Choose three arbitrary non colinear points on the plane and determine the equation of a circle 
through these three points.  Graph the resulting circle. 
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Background - Step 2 

Now that we have done a brief study of circles, we will consider how they may be applied to GPS 
System.  Let's suppose that you are in a flat plane located at the point having grid coordinates (-1, 2), 
but you don't know that fact.  Suppose there are transmitters located at grid coordinates, (3, 0), (-3, 1), 
and (0, 1).  What you do know is that you are located at distances of the square root of 20, the square 
root of 5, and the square root of 2, respectively from these three points.    You will use that fact to 
locate your position on the plane. 
 
The first thing that you do is write the equations for the three circles centered at the transmitters and 
having radii equal to their distance from your position on the plane. 
 
             2          2      2 
#8:   (x - 3)  + (y - 0)  = √20  
 
              2          2     2 
#9:   (x - -3)  + (y - 1)  = √5  
 
             2          2     2 
#10:  (x - 0)  + (y - 1)  = √2  
 

Once we have the equations, it is natural to look at their graphs and find the intersection point(s). 

Highlight each of the expressions in the algebra window and plot them. 

Note that even though there are only two independent variables, you need to plot all three of the ex-
pressions to find your position.  Why? 

You can solve the equations exactly using the Derive Solve > System command as we did before.  The 
result of this command is shown below.  Note that even though we had only two unknowns, we en-
tered three equations.    
 
                   2          2      2          2          2     2         2  
#11:  SOLVE((x - 3)  + (y - 0)  = √20 , (x - -3)  + (y - 1)  = √5 , (x - 0)   
 
                 2     2          
        + (y - 1)  = √2 , [x, y]) 
 
#12:                              [x = -1 ∧ y = 2] 
 

At this point, let's review what you know about circles.  In the following exercises draw a graph to 
illustrate that your answer is correct. 
 
Exercises: 

    2. Is it possible to find c1, c2, and r so that expression #1 has exactly one point, (x, y) that will  
satisfy the equation. 

    3. Is it possible for two distinct circles to intersect at no point?  one point? 

two points? 

    4. Is it possible for three distinct circles to intersect at no point? one point?  two points? 

   5. Why is it not possible to find three or more distinct circles that intersect in exactly three points? 

 



   p36   
 
Carl Leinbach: Introduction to Global Position Ssystem  

  D-N-L#58    
A "2 Dimensional" GPS 
 
NOTE:  The velocity given for the signal sent from the transmitters has no relation to the actual speed 
with which signals are sent from GPS sattelites or radio transmitters.  We are using this velocity only 
to keep the magnitude of the numbers we are dealing with more manageable so that the numbers do 
not get in the way of the exposition.  In part II we will deal with a more realistic situation. 
 
Prior to beginning this unit, resize your graphics screen so that the range on the x-axis is (-300, 900) 
with 4 intervals, and the range on the y-axis is (-200 , 800) with 5 intervals.  Also,because accuracy is 
important in GPS calculations set the decimal accuracy to 10 digits.  Use the Algebra Window's De-
clare >  Simplification Settings to set the Precision Digits to 10. 
 
You know that you are located at a point somewhere in this plane region.  Assume that scale on the 
graphics screen is in miles.  You activate your GPS to locate your position.  It receives signals from 
three transmitters that have been placed in the plane at locations of loc1=(75, 150), loc2=(510, 110), 
and loc3=(150,20).  The transmitters all know their own position and the exact time as determined by 
an atomic clock  in the transmitter.  The transmitter clocks are synchronized on a regular basis so that 
the time at each transmitter is absolutely accurate.  Each transmitter broadcasts its coordinates and the 
time.  The broadcast signal travels at 200 miles per second.   
 
Your GPS is able to receive the signals and record the time that each signal is received.  However, 
your GPS does not have a clock that is synchronized with the transmitters.  Thus, there is a time time 
discrepency, say d,  between the time recorded by your GPS receiver and the the actual time as deter-
mined by the synchronized atomic clocks in the transmitters.  The GPS records the signals that it re-
ceived.  The times for each transmitter are subtracted from the time your GPS received them.  These 
are recorded as t1, t2, and t3.   The numbers correspond to the times from the respective transmitter 
locations. . 
 
#13:  t1 ≔ -0.8139056099 
 
#14:  t2 ≔ 0.7980845608 
 
#15:  t3 ≔ -0.4685532484 
 

The actual times that it took to travel from the trasmitters to your GPS are t1+d,  t2+d, and t3+d, where 
d is the time discrepency of your GPS.  Thus, we have three unknown values: the x and y coordinates 
of your position and d, the time discrepency of your GPS. 
 
Your distance from each of the transmitters is the velocity of the signal multiplied by the time that it 
took to travel to the GPS.   
 
#16:  d1 ≔ 200·(t1 + d) 
 
#17:  d2 ≔ 200·(t2 + d) 
 
#18:  d3 ≔ 200·(t3 + d) 
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But these distances are the radii of circles centered at each transmitter and passing through your posi-
tion on the plane.  We are now in the situation of Step 2 above.  The one difference is that we now 
have three unknowns: x, y, and d.  However we have three equations to solve.  It may work out.   
 
              2            2     2 
#19:  (x - 75)  + (y - 150)  = d1  
 
               2            2     2 
#20:  (x - 510)  + (y - 110)  = d2  
 
               2           2     2 
#21:  (x - 150)  + (y - 20)  = d3  
 

We simply use the Solve > System option as shown above and then approximate the result to obtain 
the following result.  NOTE: the first result is not shown here.  It is the exact symbollic solution to the 
system.  It is rather messy since it involves expressions with sums of radicals and fractions of VERY 
large numbers.  We want numbers that we can recognize.  However, this will be a decimal approxima-
tion and we may loose some accuracy. 
 
                    2            2     2           2            2     2        
#22:  SOLVE((x - 75)  + (y - 150)  = d1 , (x - 510)  + (y - 110)  = d2 , (x -  
 
            2           2     2             
        150)  + (y - 20)  = d3 , [x, y, d]) 
 
#23:  [x = 452.5761121 ∧ y = 96.9671036 ∧ d = -1.092505996, x = 132 ∧ y = 145  
 
        ∧ d = 1.1] 

 

Because we have three unknowns, we, once again, have two possible solutions to the system of equa-
tions.  In this case we can rather easily eliminate one of them.  Note that if d = -1.092505996 then each 
of the distances, d1, d2, and d3 will be negative.  This is nonsense.  We would have received the sig-
nals before they were sent.  Thus, you can conclude that your position is at (132, 145) and the time 
discrepency is 1.1 second.  Define d := 1.1 and graph expressions #19, #20, and #21. 

NOTE: This can be done by holding down the <Ctrl> key and highlighting all three expressions fol-
lowed by switching to the 2D-plot window and clicking on the plot button. 

#24:   define d:=1.1 by editing this line 
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After viewing the graph clear the value for d by typing d :=  .  This action frees the symbol d so that it 
can be a variable. 
 
#25:  clear d by editing this line to read d :=  
 
It is time to try one on your own. 

First clear the graphics screen by choosing the Edit > Delete All Plots from the 2D-plot menu. 

Assume that you are working with a different GPS receiver, so you have no idea of the time difference 
between the transmitter clocks and your GPS clock.  You are still in the same region of the plane as in 
the example.   Here we go! 

Exercise 
    6.  Your GPS receives signals from three transmitters located at positions in the plane given as (320, 
190), (50, 100), and  (570, 50), respectively.  The time differences recorded by your GPS receivers 
and the three transmitters are given as t1 := 3.113941029 seconds, t2 := 3.113941029 seconds, and t3 
:= 4.102775637 seconds, respectively.  Enter these times by editing the lines below. 
 
#26:  enter t1 by editing this line 
 
#27:  enter t2 by editing this line 
 
#28:  enter t3 by editing this line 
 
Edit the next three lines to give the formulas for the distance from each of the three transmitters.  Don't 
forget that you need to include the time discrepency between the transmitters and your GPS in these 
formulas. 
 
#29:  enter the distance to transmitter #1 by editing this line 
 
#30:  enter the distance to transmitter #2 by editing this line 
 
#31:  enter the distance to transmitter #3 by editing this line 
 
Now that you have the distances, you can enter the three equations that you will need to solve in order 
to determine your position.on the plane.  Edit the three expressions below so that they contain the 
equations. 
 
#32:  equation 1 
 
#33:  equation 2 
 
#34:  equation 3 
 
After editing the above lines, solve the equations you entered using the Solve>Equations option.  In 
this case, the distances for either of the answers are positive.  However, we can eliminate one of the 
aswers rather easily.  It lies outside of the region of the plane where we know we are located.  Write 
the value for d, the time discrepancy, and plot the three circles.  
 
#35:  value for d here 
 
As a final exercise, you will demonstrate your understanding of the process by constructing a problem 
on your own for others to solve. 
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Exercise 
    7.  Choose a set of 4 points that lie within the 2-D plot region of the plane that you have laid out and 
write down their coordinates. One of these points will be your position on the plane.  The other three 
will be the locations of the three transmitters.  Determine the distance of your point from each of the 
transmitters.  Finally decide on a value for the variable, d, which is the time discrepency between the 
transmitters clocks and the clock on your GPS. 
         a. Determine the time that it takes for each of the signals sent from the 
             transmitters to reach your GPS. 
         b. Using d, determine the values for t1, t2, and t3, the differences  
             between the time sent by each transmitter and the time the signal  
             is received. 
         c. Write out your problem in a manner similar to the example and  
             problem given above. 
         d. Solve the problem and compare the answer with the coordinates 
             for your position.  This is a check that you correctly constructed 
             the problem. 
#36:  InputMode ≔ Word 

 
 

One more letter from Ernest Carpenter: 

Ernest Carpenter (South Africa) 
The article on Turtle Graphics on the TI-92, in DNL57, also brought back some nice memories when I 
first obtained my TI-92+ (before that I was actually a die hard HP48GX fan☺ and also used the QLIB 
referred to in the “Actuarial Math” article) and TG was one of the first programs I load onto it!  
  
Now that I’m finished babbling, just a few quick questions to get your option on a matter or two: 
  
¾ Do you think we will see a scaled down version of Cabri3D for the TI-89/92+/V200? 
¾ Do you think from an education point of view whether the TI Graphing Calculators (or Graph-

ing calculators in general TI,HP, Casio) would still be around for a while or will it disappear 
and make place for more windows based handhelds like the PocketPC or PalmOS devices? 
The main reason for this question is to see if developers or users in general should still focus 
on developing software/apps for the current devices or shift their efforts towards the new 
technology marked?  

¾ I know that the use of technology in RSA, especially on a secondary (high school) mathemati-
cal level, is almost non-existent. How do the students/pupils in Europe benefit from using 
technology, like for instance the TI-92 or Derive? 

  
Finally, any indication when you will ‘publish’ the articles “Tools for 3D-Problems” and “CAD-Design 
with DERIVE and the TI”?  
(I know I’m persisted with the above mentioned question, but maybe my persistence would pay-off☺)  
 
Thanks again for all the information and articles, I appreciate it! 
  
Enjoy your day! 
  
Regards 
Ernest Carpenter  
----------------------------  
CADD Co-ordinator  
Strategic Projects  
De Beers(NM)  
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Titbits from Algebra and Number Theory (30) 

 
by  Johann Wiesenbauer, Vienna 

 
Let’s consider the following innocent looking problem: Given a positive integer n, 
is there a right triangle with rational sides a,b,c and area n? In other words, we 
are looking for rational solutions (a,b,c) of the system consisting of the two 
equations: 

2 2 2 a ba +b =c ,   = n2
                                            (*) 

Since (a,b,c) is a rational solution w.r.t. to the area n, if and only if (ta,tb,tc) is a 
rational solution w.r.t. to the area t2n for any nonzero integer t, there is no loss 
of generality if we always assume that n is squarefree in the following. A 
squarefree positive integer n, for which the system of equations above has ra-
tional solutions, is called a congruent number. 

Just to get a feeling for the problem, let’s look now into some small cases. For 
example, are there rational solutions for n = 5 and n = 6, respectively? Well, this 
shouldn’t be too hard for n = 6, as the “Egyptian triangle” with the sides 3,4,5 
clearly solves the problem. On the other hand, it might take you a while to see 
that n = 5 is a congruent number and e.g.  a = 3/2, b = 20/3, c = 41/6 is a rational so-
lution of (*) here. Just in case you wonder why I didn’t start with the first 
three squarefree natural numbers, namely n = 1, 2, 3, the answer is very simple: 
There aren’t any rational solutions in those cases, but this is far from being ob-
vious. (E.g., the case n = 1 was settled by Fermat around 1650.) 

 
There is a completely different way of looking at this problem, which will give us 
valuable insights though. Using Derive the following computations show that for 
a fixed n we can assign to each rational solution (a,b,c) of (*) a rational point (x,y) 
with y 0≠  on the curve 2 3 2y = x n x−  and also the other way round. 
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Algebraic curves of the form )x(fy2 = , where f(x) is a polynomial over some field 
F without multiple roots, are called elliptic curves.  In many applications, it suf-
fices to consider elliptic curves of the special form 

baxxy 32 ++=   (a,b∈F)                                           (**) 

where the condition that the polynomial on the right-hand side has no multiple 
roots becomes the condition that its so-called discriminant 23 b27a4 +=∆  doesn’t 
vanish in F. 

In the special case F= we can take advantage of sliderbars for the parameters 
a and b (e.g. in the range [-10,10]) to produce the following pictures: 

 

 

 

 

a= -5, b = 3 

a= -5, b = 5 

a= 0, b = 0 

a= -3, b = 2 
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Note that only the first two curves are elliptic curves, while the other two are 
not due to singularities. 

Maybe you have already heard of elliptic curves and their usefulness, e.g. in solv-
ing Diophantine equations (the most notable example is A.Wiles’ proof of FLT!) 
and in encrypting messages. Hence, unless you are already an expert in this field, 
you might wonder: What is so special about them? 

Well, there are many possible answers, but one of the most outstanding fea-
tures of elliptic curves is certainly the fact that it is possible to define an addi-
tion on their points which turns them into abelian groups. 

Considering again the field F = , the basic procedure to obtain the sum of two 
points P and Q is the following: Draw the chord through P and Q, find its inter-
section point R with the curve and define P+Q as the mirror image of R w.r.t. the 
x-axis, as shown in the picture below. 

 
The rough description above must be supplemented though in the case, where P 
and Q have the same x-coordinate. Then either P and Q coincide, in which case 
the chord becomes a tangent or/and P and Q are mirror images to each other 
w.r.t. the x-axis. In the latter case, we use the usual convention from projective 
geometry that the intersection point R with the curve (and hence also P+Q) is 
the point O at infinity. In particular, this point O has to be added to the points 
of the elliptic curve and plays the important role of the neutral element for our 
addition.  

 

Let’s now use the informal description above to compute the coordinates of P+Q, 
where P x y= ( , )1 1  and Q x y= ( , )2 2 ,  under the assumption that OQP ≠+ . Then 
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is the slope of the chord or tangent, respectively, and after an easy computation 
we get for the  coordinates of )y,x(QP 33=+  the equations 

x k x x y y k x x3
2

1 2 3 1 1 3= − − = − + −, ( )  

It is important to notice that these formulas, actually derived under the condi-
tion F = R, also make sense for an arbitrary field F, and although there is no 
longer a geometrical interpretation then, it is still true that the set of points of 
an elliptic curve along with this addition is always an abelian group.  

When trying to implement this addition (and, of course, this is the next point on 
our agenda!) we must somehow specify the field F. In order to avoid making 
things to complicated for a first approach (for example, by allowing arbitrary 
fields for which the basic operations are given by functions defined by the 
user), I will consider in the following only the case, where F is either a subfield 
of the field  of complex numbers or a residue class ring mod p for some prime 
p. Then a routine for the addition of two points U and V on an elliptic curve given 
by an equation (**) could look like this: 

 
 
A few comments might be in order here. First, you should know that in the case 
p = 0, i.e. if F is assumed to be a subfield of C, those reductions mod p will do no 
harm, although they are of course superfluous! Second, in the case F = p , we 
will occasionally p allow to be a composite number, which leads to an “elliptic 
pseudocurve”, for which addition is sometimes undefined. In those cases, a  non-
trivial divisor is returned as the result of the addition, which could be just  
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the thing you were after. 

For the time being, we’re dealing with a more down-to-earth problem though, 
namely the determination of some points on an elliptic curve again given by an 
equation baxxy 32 ++= . If F = p , and p is not too large, we should be able to 
compute even all its points. As for other fields, we restrict ourselves here to 
the most important case F = , where the following routine computes all points 
up to a certain user-defined “height” h, which is an upper bound for s,r  in a 

representation rx = s  of the x-coordinate of a point (x,y) on the curve. At any 

rate, the point O at infinity is added. 

 
Before applying this routine, one should make sure though that the parameters  
a and b are chosen appropriately, i.e. 23 b27a4 +=∆  must not vanish in F, as  men-
tioned above. This can be accomplished by  

 
 

At last,  we are ready to apply the tools we have gathered so far to our  
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introductory problem! (Note that all the curves xnxy 232 −=  at issue are non-
singular due to the nonzero discriminant 623 n4b27a4 −=+=∆  in F = .) Okay, 
maybe still not quite, as it will be convenient to have a routine that translates a 
rational point OU ≠  on those curves with 0y ≠ into the corresponding right tri-
angle with rational sides a,b,c. 

 
As you can see above for n = 6, by searching for rational points up to the default 
height h=100, we have got another (far less obvious!) right triangle with rational 
sides a = 7/10, b = 120/7, c = 1201/70 and area 6. 

What about the other squarefree numbers n in the range 10n1 ≤≤ ? Take a look 
at the following table with all the rational points found up to height 100: 
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Well, I already told you that 1,2,3 aren’t congruent numbers and from the table 
we can conclude that not only 5 and 6, but also 7 is a congruent number for sure. 
But what about n = 10? It is true that we haven’t found rational solutions of 

x100xy 32 −=  except for the trivial ones, which are of no use here, but the tan-
talizing question remains: Was this because our search limit was simply too low 
or can it be really proven that n = 10 is not a congruent number? 

If this is what you asked yourself (and hopefully you did!) then I have good news 
and bad news for you. First the good news: There is a remarkably simple test by 
J.B.Tunnell (1983), in order to find out whether a squarefree positive integer is 
congruent or not. The bad news: Only “no” answers are provably reliable, while 
“yes” answers are not. It must be said though that no counterexample has been 
found so far, in fact, such a counterexample would contradict the famous con-
jecture by Birch and Swinnerton-Dyer (one of the 7 millennium problems, each 
worth $ 1,000,000 for the first solver), which is widely accepted by the commu-
nity of mathematicians. 

For this test, we must compute the numbers r and s of integer solutions of the 
equations 2 2 2 nx + 2ay + 8z = a  and 2 2 2 nx + 2ay + 32z = a , where )2modn(2a −= , and 

simply check whether r = 2s or not. The following routine will do the trick. (By 
the way, if you feel like a programming challenge, I cordially invite you to have a 
try at this task yourself before looking at my solution below. Although it is not 
too hard in principle, one has to take care not to get lost in too many cases and 
subcases, resulting in ugly if-statements.) 

 
As you can see from the table below, 10 is not contained among the numbers be-
low 100, that passed the test, which is a proof that it isn’t congruent, indeed. 
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From a closer look at the table you will also learn that all squarefree numbers of 
the form 8k+5, 8k+6 or 8k+7 in the given range passed the test and hence are  
congruent numbers, as it has been proven by others that all results of Tunnell’s 
criterion are correct, if n < 1000. In fact, congruent numbers not of this form  
are a minority, like 34, 41, 65 in our example above. 

Before coming to an end, let’s also talk a little bit about the case, where F = p 

for some prime p, which plays an important role in modern cryptography.  One of 
the most important issues there is the computation of the number Np of points 
on an elliptic curve E again given by the equation baxxy 32 ++=  (a,b∈F). It turns 
out that the algorithms used for this computation are very similar to those in-
troduced in my last column to solve the discrete logarithm problem (DLP) and it 
will soon become clear why.  

A very first, though very crude implementation, would make use of our routine 
points(a,b,p) and simply count the number of resulting points, i.e. 

 
As the following simple example shows this is far too slow though. 

 
  

A better idea is to compute for every x in the range {0,1,…,p-1} not the points 
with this x-coordinate, but only the number of possible y-values, i.e. the number 
of solutions of baxxy 32 ++≡  mod p. According to Euler’s criterion from the the-
ory of quadratic residues this number is given by )pmod)baxx((1 2/)1p(3 −+++ , 
which yields the implementation 

 

 
 

(18.4s ) 

(0.03s !!) 
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On the other hand, the following computation  

 
still took 156.5s on my PC! It looks as if we are not yet arrived at a method for 
counting points on elliptic curves mod p, where p has say 10-20 digits! 

Hence, let’s use some results from the theory of elliptic curves, which may bring 
us further. In the first place, there is the well-known theorem by Hasse, which 
states that the number of points of an elliptic curve E mod p, which we denote by 
#Ep in the following, always lies in a relatively close vicinity of p + 1. To be more 
precise, the absolute difference )1p(E# p +−  can never get larger than p2 . 

How can we exploit this feature for our purposes? 

Well, as you might know, the order of an element of a finite group is always a 
divisor of the group order. This means that starting with an arbitrary point U on 
the elliptic curve Ep, there is always some multiple kU with k “nearby” p + 1, such 
that kU = O. If the order of U is “big enough”, more precisely not smaller than 
the length p4  of the “Hasse interval” ]p21p,p21p[ ++−+ , then this k must 
be #Ep itself, as it is the only candidate. 

Okay, let’s do the programming now. In the first place, we need a routine that 
computes for any integer n the multiples nU of a point U on the elliptic curve Ep, 
which is given as usually by an equation baxxy 32 ++= . Again, try to write this 
routine yourself, before looking at my solution below. 

 
We will later have many opportunities to see the “power” of this small jewel of 
programming, hence I’ll skip examples here. 

The next thing we must do is to solve the equation kU = O for a given point U, 
where the integer variable is the unknown here. This is where our algorithms for 
the DLP come into play. (Hopefully, you can see this yourself, although the op-
eration is written additively, whereas I used the multiplicative notation to intro-
duce the DLP in my last column!) For example, by slightly adapting the  
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baby-step giant-step algorithm we get the following routine. (Note that the 
variables u, a, p have the same meaning as above!) 

 
Finally, to get the order of U, we must successively remove from the returned k 
all primes q for which still k U = Oq

 holds.  

 

Well, are you ready for the most advanced Np(a,b,p) so far? Here you are! 

 
 



   p50   
 

Johann Wiesenbauer: Titbits 30  
  D-N-L#58   

 
For those of you, who, who wonder how this works in detail, here comes a little 
support. At first, you should be able to see that s_ = 1 means that for a ran-
domely chosen x in {0,1,..,p-1} there exists a point (x,y) on the curve indeed. In 
the opposite case s_ = -1, there is still no need to despair, as every curve Ep has a 
“twin brother” E’p, called its quadratic twist, with the property that there is a 
point with a given x-coordinate on Ep if and only if there is no such point on E’p. 
Its equation is given by 

3232 bgxagxy ++=  

where g is some quadratic nonresidue mod p. From this easily follows that  

#Ep+ #E’p = 2(p + 1). 

Hence, if we know one of the two summands on the left, we know also the other 
one! This will do for all primes p>229 as noted by Mestre. If this condition is not 
fulfilled, then we simply use one of the previous formulas, which are fast enough 
for those small primes! 

Okay, I have to come to an end, as Josef is already tearing out his hair, both 
because of the length of this paper and its late delivery. Hence, let me conclude 
with some small examples for the routines above. First, let’s take a really huge 
number k, say the lcm(1,2,..,30000), to form the multiple kU for U = (1,1) mod 7F . 
(After all, Fermat told us that 7F  is a prime, didn’t he?) 

 

 
Whew, what’s that? Obviously Fermat was mistaken and our routine has re-
ported a 17-digit prime factor p of his number. And now the acid test for our 
third try at Np(a,b,p), which is the time-consuming part of ord(u,a,p)! 

 

It worked! And what’s more, it worked in a reasonable time!  What you saw above 
is the basic principle of the celebrated ECM (=Elliptic Curve Method), intro-
duced by H.Lenstra Jr. in 1987. As you see, by a fortunate coincidence the or-
der of the point (1,1) on the elliptic curve E2 9 8 2 4 7 9 4 6 8 9 7 0 0 4 0 5  splits up into many 
small prime factors, the largest being 26263, which is smaller than our bound 
30000 above. Actually, without this prime factor, the order would be even 
“smooth” w.r.t. to the much lower bound 4783 (or say 5000). In an actual  

(22.7s !!) 

(106.7s) 
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implementation of the ECM, one takes advantage of this fact by introducing two 
bounds B1 and B2, where B1 covers all prime factors with one possible exception 
whereas  B2 (usually 10 to 100 times larger than B1) covers also this one-off.  

As for the following Derive-implementation, here is the meaning of the vari-
ables: n is the number to factor, U is a point on the elliptic curve used, a is the 
coefficient in the equation of the curve, and s and t are the two bounds above. 
(Note that, as many times before, again the seemingly missing coefficient b of 
the curve equation is determined implicitly by the coordinates of the point U!) 

 
Will this be notably faster than our crude computation above? Sure! 

 

Don’t take this time as the total running time for ECM though, as there are 
quite a few failures until you find the “appropriate” value a = 139 above. Okay, 
okay, let’s stop here ... 

(As always, questions or remarks to j.wiesenbauer@tuwien.ac.at ) 

(4.89s !) 
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Recommended Readings 

 
Liebe Kolleginnen und Kollegen 
Hansruedi Vollmer und ich haben beschlossen, die 2. ueberarbeitete und verbesserte Aufla-
ge unseres Buches "Skalarprodukte, Schwingungen, Signale" auf dem Bildungsserver  
 

www.swisseduc.ch 
 
kostenlos anzubieten. Bitte weitersagen. 
 
Mit den besten Gruessen 
Hansruedi Vollmer und Hansruedi Schneebeli 
 
Hansruedi Vollemer and Hansruedi Schneebeli offer a free download of their book “Scalar 
Products, Oscillations, Signals” (in German) from www.swisseduc.ch. 
 
 
 

Information provided by Guido Herweyers, Belgium 
 

You can find the pdf-version of “A CASE FOR CAS” online at  
 

http://www.uhasselt.be/scholennetwerk/ig/CAS/CAS.html    
(from www.t3vlaanderen.be  Æ publicaties ) 

 
This is a T3-Europe product written by Ian Forbes, Gert Schomacker, Guido Herweyers,  
René Hugelshofer and Josef Böhm. 
 
 
 

Information provided by Robert McCollum, USA 
 
This is just a reminder to send in a proposal to speak at the NCTM Chicago Regional to be 
held in Chicago Sept. 20-22, 2006 at the Hyatt McCormick Place. The deadline for submissi-
ons is JULY 11, 2005 (this summer!) 
 
I would love to see you sharing your expertise with CAS at this conference.   
 
The URL is                                         www.nctm.org/speak/  
 
They are particularly looking for CAS speakers but most anything you submit would be ap-
preciated. 
 
Take Care, 
Bob 


